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Characteristics of Powerful Literacies 
 
• Reads a wide variety of self-selected materials for both enjoyment and 

information. 
• Makes connections between learning and life, and evaluates the impact 

of current issues. 
• Formulates and defends ideas and opinions from an interdisciplinary 

perspective. 
• Manages complex information by analyzing, synthesizing and evaluating. 
• Seeks, accepts and overcomes challenges using critical and/or creative 

thinking and problem solving. 
• Uses Standard English effectively in speaking and writing to inform, 

persuade and entertain. 
• Demonstrates mastery of content by creating original stories, poetry, 

role-plays, illustrations, non-linguistic representations, or other creative 
means. 

• Applies divergent thinking skills and can create order from disorder. 
• Activates metacognition to maximize learning and evaluates one’s self-

knowledge. 
• Seeks new understanding from various sources. 
• Can dialogue, debate, & lead effectively in all types of settings & with all 

types of groups. 
• Demonstrates personal responsibility for learning. 
• Demonstrates an intellectual curiosity & understanding for the arts. 
• Persists to develop personal meaning from information that is indefinite 

or inconclusive. 
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PowerPoint Sidekicks 
 
Although many of the tools we use in schools were developed for adults, they 
can be adapted for use by young people.  

1 line 2 lines 3 lines 
 

4 lines 8 lines side page 
 

bottom page full page half page 
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PowerPoint Sidekicks Directions 
 
Use the top blue area for audio directions, links to resources, or other 
information. 
Use the white space for charts, graphs, photographs, drawings, clipart, video 
clips, audio clips, or other visual materials. Consider providing many options. 
Then let students make choices. 
Use the bottom blue area for additional navigation. 
Use the Speakernotes for additional directions or for citations. Remember, 
you can print out the Speakernotes. 
Use the two pieces of paper for making comparisons, two points of view, two 
ideas, dialog between two characters. 
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PowerPoint Sidekick: Information Formats 
 
Students need to be able to compare and use different formats of 
information. Think about the many ways that pictures, words, and sounds 
convey meaning. How is a photograph different from a piece of clipart? How 
do visuals convey information? How do visuals have different meaning 
depending on the way they show ideas? How are people, places, and things 
portrayed? What about realism and historical accuracy? Are serious or 
humorous resources needed for particular situations? 
 
Design an activity that uses photographs, clipart, and line art of the same 
concept. Combine a social studies and communication arts standard. Consider 
writing a class book with one story in clipart and another story with 
photographs. Also, think about on and off computer activities such as word 
cards.  
 
Let's use a review of state symbols as an example. Notice that the project 
includes clipart, photographs, audio, and a place to write. Clipart of the 
Pennsylvania state insect often doesn't look like the actual firefly, so it's 
important to also provide photographs. Students also need to distinguish the 
firefly from other insects. In this case, students are asked to delete the 
insects that aren’t fireflies. They can tell they made the right choice when 
they see the smile under the firefly. To keep the assignments short, consider 
creating each symbol as its own PowerPoint document. You may also wish to 
save the document as a template. Now, create your own. 
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Help students see that information comes in different forms such as words, 
pictures, and sounds. Also, show different ways to represent ideas visually 
such as photographs, clipart, and line art (see the Washington example). Also 
use artwork (see the example below of fields). These activities will help 
students transfer learning to new situations. For example, the economics 
activity provides students with both clipart and photos. Students are asked: 
What are goods and services? Look at each picture. Does it show the use of 
goods or services? Move the picture to see what it says underneath. Choose 
one picture that shows goods and one that shows a service. Write about each.  
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Also, consider using both clipart and photographs for projects on local topics. 
You may even want to use photographs of local people that your students 
interview.  
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PowerPoint Sidekick: Info Evaluation 
 
Students need to be able to compare different sources of information. Adapt 
the evaluation form and activity by editing the Master slide (Pull down the 
View menu, choose Master, select Master Slide). Or, use my form and adapt 
the assignment. It works best to provide students with specific titles and 
website addresses. Make a class folder (virtual or paper) containing student-
reviewed websites. For example, each student might review one website 
related to the social studies unit. 

 
If you're looking for a fake website 
for young people, use Facts About 
Idiotica. Also provide a good 
website for comparison or book 
resources. 
Use Wikipedia and Wikipedia Jr. to 
help students understand how 
websites can be constructed 
collaboratively. 
 
Consider adapting this project to evaluate other media such as books or 
videos. For example, you might add a book cover and change the evaluation 
questions to topics related to character, plot, setting, etc. 
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Provide students with 4 websites to explore. Compare what you learn from 
each source. Who is the author of each website? Be sure to include websites 
with different perspectives, media (i.e., audio, video, graphics), interactivity, 
and reading level. Ask students to rate the sites and describe which provided 
the best source of information and why. Use smile faces for evaluation in the 
younger grades. With older students, consider a YES/NO or numeric rating 
system.  
 
Create a student assignment asking learners to write five questions related to 
their topic on the five slides. Then use at least two resources to answer the 
questions and compare their findings. The resources can be websites, books, 
videos, or other materials.  
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Creating Call-out Bubbles 
 
Use “callout” bubbles in PowerPoint to create comic strips, show 
conversations, provide directions, and many other activities.  
 
To create call-outs:  

Click the Autoshapes option on the Drawing toolbar. 
Choose a call-out you wish to use. 
Click and drag to create the bubble. 
Resize by dragging a handle/dot from the edge of the graphic. 
To send the bubble to the back or front of another picture,  

right-click on the edge of the bubble and choose Arrange. 
To move or resize the directional area of the graphic,  

drag by the yellow dot. 
To enter text, simply select the graphic and start typing.  

You will not see an I bar. 
You can change the line thickness, 

color fill, and font of the bubble. 
 
Creating Templates  
 
If you create a starter project for 
students, you’ll want to save it as a 
template so they won’t save over your 
original. When you’re done creating the document, save it as a template. When 
students open the template, it will open as an Untitled document. Then, they 
can save it as their name rather than saving over the original. 
 
To save your project as a template: 

Pull down the File menu, select Save As.  
Under the Format pull-down option, choose Design template.  
Name your file. Notice that it now has a .pot file extension  

rather than a .ppt file extension. 
Be sure to notice where the file is being saved.
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Sequential Art and Comics in the Classroom  
 
Let’s use picture books, sequential art, and comics as tools for teaching 
critical thinking skills related to sequencing across the curriculum. 
 

• Use online sequencing activities. 
• Read online comics. 
• Use comic strip creation tools. 
• Adapt online lessons. 
• Use “callout” bubbles in PowerPoint. Find these on your drawing palette 

under Autoshapes. 
 
Use PowerPoint as a tool for storytelling. Let’s tell stories about shopping. 
Use the clipart provided to design an activity for your students. Design an 
assignment focusing writing.  
 
Sequencing with Timelines in the Classroom  
 
Besides comic strips, another way for student to tell stories is through 
timelines. These are particularly useful in history, but also in other areas of 
the curriculum where sequencing is important. 
 

• Use online timeline generators. 
• Use PowerPoint for timelines. 
• Adapt online lessons. 

 
Use PowerPoint to help students build timelines. Provide students with photos. 
Ask them to place the photos in sequential order. Then write about this 
sequence of events.  
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The Power of Sound 
Sound is a great way to address the diverse learning needs of your students. 
Sounds can be inserted into most software tools. Begin by incorporating audio 
into existing projects. For example, you might record audio directions or 
information in Spanish. Add questions and answer audio buttons to projects. 
Next, try audio on single slide projects.  
  
Sound Ideas 

• Create audio “hot spots” to hear the name of an object, description, or 
other information. 

• Tell a story by clicking on different objects. Create an interactive story 
such as “The wind is blowing my hair,” “I’m riding a horse,” or “Susan is 
catching a butterfly with her net”.  

• Record audio questions such as “How many butterflies”? Record audio 
answers such as “I found 2. What about you?” 

• Record audio questions about the relative locations of items in the 
picture such as “above/below,” “inside/outside,” “high/low”.  

• Click on objects and say the color word such as “The banana is yellow.” 
• Use audio to categorize elements such as “real” and “pretend.” 
• Click on the object and use particular types of words such as “Joe 

swings from the tree. Swings is a verb.”  
• Design an activity that involves students recording their voice as one of 

the characters. This works well with a pair of students.  
• Use audio to describe the plot, characters, and setting.  

  
Teacher-Created Sounds 

• Teacher-created directions. 
• Teacher-created audio to read from text on a screen. 
• Teacher-created audio for specific vocabulary. 
• Teacher-created audio feedback and remediation during tutorials. 
• Teacher-created audio to provide students with individualized feedback 

on work. 
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Sound Effects 
• Pre-recorded sound clips 
• Student-produced sounds  

 
Music 

• Music recorded directly from local productions 
• Music from digital files such as web, CD, etc. 
• Music from locally made instruments 

 
Spoken Word 

• Famous speeches   
• Oral histories   
• Narration for a “museum” exhibit 
• Reading samples   
• Skits and e-plays  
• Step-by-step directions 
• Storytelling 

 
Electronic scrapbooks and portfolios 

• Student-created audio reflecting on a project (i.e., likes, dislike, 
strengths, challenges). 

• Student-created audio describing the process (i.e, first, second, finally). 
 
Tips 
Place sounds in standard locations on the screen so users can find them easily. 
If sounds are on invisible buttons, be sure to provide good directions! 
Use special icons such as a teacher button for teacher audio. 
Use Audacity (http://audacity.sourceforge.net/) for editing digital audio. 
 
Class News, Radio, and Podcasts 
Brainstorm ways of integrating podcasting into your classroom. 
Use Web-based Audio Resources 
Design an activity that connects sounds or music to a content area standard in 
communication arts, art, or social studies. 
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Adding Sound to PowerPoint 
 
To insert a sound: 

• Pull down the Insert menu, select Movies and Sounds, choose Record 
Sound. 

• Give your sound a name. 
• Click the Record icon and make your sound. Click Stop. 
• Click Play and check your sound. Click Save. 
• Choose to play automatically or when clicked. 
• Drag the sound graphic wherever you wish. 

 
To create a transparent object that will cover another object: 

• Use the draw tools to create an oval or rectangle. 
• Select the line color and choose No Line. 
• Select the fill color and choose No Fill. 

 
To put a sound on a graphic or transparent box: 

• Record your sound. Be sure to give it a name. 
• You can delete the sound icon. 
• Click on the object such as the text or graphic. 
• Pull down the Slide Show menu, select Action Settings, check Sound. 
• Choose the name of your sound from the list. Click OK. 

 
To record narration: 

• Pull down the Slide Show menu, click Record Narration. 
• Under Recording option, check the type of microphone. 
• Uncheck Link narrations because you want to embed your audio. 
• Click Record and begin recording your narration as you move through the 

slides. 
• At the end of your show, click YES to save the narration and the timed 

slide show. 
• A sound icon will appear on each slide. 
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To insert a sound you’ve created in other software or a file you’ve 
downloaded: 

• Pull down the Insert menu, select Object. Choose Wave Sound or 
Windows Media Player. Then, select the file. 

• In some versions, a sound can be inserted using the Insert Movies and 
Sounds. 

• In some versions, you can use the Movie option to insert a sound. 
 
To be sure that your sounds are saved with your project: 

• Pull down the File menu, select Save As. Under the Format menu, choose 
PowerPoint package. Name your file. It will create a folder and place the 
PowerPoint presentation inside along with any necessary files. 

• If you want the program to run automatically, also check “Start Slide 
Show when opened”. 

 
Adding Sound to Word 
 
To insert a sound: 

• Record your sound in a program such as Audacity. Then, pull down the 
Insert menu, select Object. Choose Wave Sound or Windows Media 
Player. Then, select the file.  
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PowerPoint Project Ideas 
 
When using starter projects in the classroom, it’s a good idea to create three 
versions: (1) empty version that can be modified for use with different 
content, (2) a version with content ready for students to use, (3) an 
exemplary, completed project that can serve as a sample. You may also wish 
to create a tutorial version that contains ideas, explanations, definitions, and 
elaboration. In other words, create a tutorial that introduces or reviews the 
key concepts within the context of an example.  
 
Speakernotes Uses 
Copy and paste quotes from websites or other sources. Be sure to cite the 
source. Then, use this information in a “bubble project” in the body of the 
slide. For example, “I am the wildflower of Virginia. I was selected because… “ 
 
Bubbles 
Use the cross section books for ideas. Use the digital camera to photograph 
individual pages. 
 
Manipulating Objects 
Many activities involve students moving objects (wordart, pictures, sounds) on 
the PowerPoint slide. 
 
Choosing Objects. Provide students with lots of objects to select or delete 
for their projects. Consider all kinds of visuals such as clip art, photographs, 
line drawings, charts, graphics, etc. To delete objects, simply select the 
object and press the delete or backspace key. 
 
Organizing Objects. Provide students with objects and ask them to 
categorize such as beginning sounds, types of rocks, types of transportation, 
etc. 
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Matching Objects. Provide students with lots of words and visuals. Then, ask 
them to organize and match the items. They can delete any items that don’t 
apply. 
 
Sequencing Objects. Students can sequence pictures and Wordart. For 
example, students might place items in order from first to last or oldest to 
newest. Consider building a timeline and asking students to place objects in 
the correct location. You can also use their approach for cycles. 
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Powerful Literacies and Learning Spaces 
 
Let's put it all together. Designing effective, efficient and appealing PowerPoint 
Learning Spaces involves more than just building a PowerPoint Sidekick. The most 
effective learning spaces combines authentic assignments and hands-on learning 
with technology tools to create synergy in the classroom. Consider activities that 
involve students in asking questions, solving problems, and conducting inquiries. 
 
As students are learning about the inquiry process and specific information skills, 
it's helpful to provide Inquiry Guides that help students through a specific task. 
 
Inquiry Guide: Fossils  
After reading the story about Uncle 
Joe’s fossil, your job is to do a web 
search to help you identify the rock.  
 
Before you begin, write down clues 
from the story that will help in your 
search. As you explore, be sure to 
investigate words you don’t know 
and use Google images to locate 
photos of unknown fossils. 
Then, go to the next page to share 
your findings. 
 
On the right you’ll find the two 
photos we took of the fossil. You 
can resize these pictures. Then add 
your own visuals.  
 
Finally write a letter to Uncle Joe 
about what you found. Use the space 
below to take notes that will help 
you include facts in your letter. 

 


